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PART 1 

INTRODUCTION 
 
The Canadian Automated Export Declaration (CAED) represents the culmination of 
consultations with representatives of the Canadian exporting community, Statistics 
Canada (STC), Canada Border Services Agency (CBSA) and other government 
departments. 
 
Statistics Canada and Canada Border Services Agency have jointly developed a user-
friendly ‘Windows’ based software which features the ability to memorize screens, drop 
down menus, and keyword search functionality for Harmonized System (HS) coding at 
the 8 digit level.  This software can also print an Export Declaration and / or generate a 
flat file in the prescribed format necessary for Internet transmission to the Federal 
Government of Canada. 
 
The main objectives of the Canadian Automated Export Declaration (CAED) Program 
are: 
 

• To promote the use of the CAED software.  This software captures the data to a 
local database and then formats the data for electronic submission to the Federal 
Government. 

• To improve the quality of the reported data by using a user-friendly collection 
vehicle.  The CAED software uses embedded code-sets for HS coding, province, 
country, currency, unit of measure and port fields.  

• To improve the completeness of reported data.  
• To provide exporters with a variety of transmission options which will enable 

exporters to submit their export declarations to the Federal government in a 
convenient and timely manner. 

 
 

GETTING STARTED 
The User Guide presents and explains the basic steps in using the CAED software, as 
well as the steps required to complete the Export Declaration Form. 

Using the Software 
 
The CAED 2016 software version 16.0 has been developed for use with Windows XP 
(SP2 or later), Windows Vista, Windows 7, Windows 8 and Windows 10. 
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System Requirements 
  

• An optical drive capable of reading the CD-ROM format (if installing from CD-
ROM media)  

 
• A screen resolution of 1024x768 or greater. 

 
 
• One of the following must be installed before using the CAED software: 

- Microsoft Office 2007 
- Microsoft Access 2007 
- Microsoft Office Access 2007 Data Connectivity Components   

 
• Microsoft .NET Framework version 3.5 

 
Note: The Microsoft Office Access 2007 Data Connectivity Components and the 
Microsoft .Net Framework version 3.5 are free products that can be downloaded from the 
Microsoft web site. See the CAED installation guide for more details. 

Installation Procedure 
 

• Decide whether the software will be installed as a stand-alone or multi-user 
(LAN). 

• For detailed installation instructions, please refer to the separate Canadian 
Automated Export Declaration (CAED) 2016 version 16.0 Installation Guide. 

 

How To Get Help With The Software   
 
As you use the CAED software, you can access the Help screen by clicking the Help 
drop down menu from the toolbar, or you can call the CAED Help Line, toll free at 1-
800-257-2434 or locally at 1-613-951-6291 (Monday to Friday, 07:30 – 17:00 EST). 
 
When reaching the CAED Help Line, you will be asked "How can I direct your call?".  
Please indicate one of the following options to the receptionist: 
 

1. Software question or problem 
2. Licence or Authorization request  
3. HS-08 coding help 
4. Other information (i.e. how to get a Business Number)  

 
Your call will then be transferred to the appropriate Information officer. 
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PART II 

HOW TO CREATE AN EXPORT DECLARATON 
 
The first time you access the software; you will be prompted for a Licence Number. 
Simply call 1-800-257-2434 and one will be provided.  You will also see the release 
notes for CAED 2016 open in the background.  Each subsequent access of the software 
will result in a popup box asking if you want to view the release notes.  This behaviour 
will continue until you click the checkbox that says ‘Do Not Ask Me Again’.  It is highly 
recommended that you complete a TEST export declaration with a Statistics Canada 
agent at this time. 
 

1. To open the software, click Start, Program, CAED Icon, then click the 
CAED 2016 Icon; 

2. When the banner screen appears, select the language of your choice – either 
English or French 

3. Select Continue; 
4. At the main Application Screen Select File; 
5. Select New. 

 
New will allow the creation of a new form.   
 
Open will allow access to a previously created form. 
 

GENERAL FEATURES 
 
The CAED Export Declaration is almost identical to its paper B13A counterpart.  The 
electronic version has broken the B13A into the following 7 Form Sections and each 
section can be accessed by clicking on the corresponding tab: 
   

  Exporter      Commodity 
  Consignee      Other Export Details 
  Service Provider     Customs Details 
  Certifier 

 
Each of these sections is controlled by five function buttons which are found at the top of 
each screen: 
 

Memorize section 
 
The Memorize section function allows the user to save frequently used sections to a 
directory.  Memorizing data will reduce the time required for data entry and lowers the 
risk of possible typing errors.   
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The user can develop memorized lists in the Exporter, Consignee, Service Provider, 
Certifier, and Commodity sections of the application. 
 
Once a section is complete, click on Memorize section to save the data to a Memorized 
List. The saved information will then become accessible by the arrows button to the right 
of the drop down list when completing subsequent declarations. 
 

Memorize section as default 
 
Like the Memorize function, the Memorize section as default function adds completed 
sections to a memorized drop down list.  In addition, each time that you will create a new 
form, this section will be filled automatically with the default information. 
 

Save Section 
 
Each of the seven sections must be validated prior to completion.  As each section is 
completed, validate the information on the screen by clicking the Save Section function.  
If all mandatory fields are complete, a green check mark will appear beside the 
corresponding tab.  Once all the sections have been validated and 7 green check marks 
appear beside the corresponding tabs, the bottom status bar will be updated to indicate the 
form is complete (Original) and that the declaration can be sent directly to the 
Government of Canada via the Internet. 
 

Clear section 
 
This feature enables the user to clear the screen.  Click on Clear section to remove data 
from all fields of the section displayed on the screen. 
 

Edit form 
 
This feature enables the user to edit a form that has been completed but has not been sent.  
A form must be edited by only one user if used on a LAN version. 
 
 
Other functions that are available through the File menu are as follows:  

Create a new Template 
 
This option allows the user to use a previously completed export declaration form as a 
template for new export declarations.  This time saving option allows the user to name 
declarations in a fashion easily recognizable or identifiable to the user. This feature may 
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be of particular interest to exporters who frequently export one product to the same 
destination. (See part III for more details). It is important for exporters to note that when 
utilizing a template they must make sure that the template complies with the Reporting of 
Exported Goods Regulations and that all required fields are completed. 
 

Amend Sent Form  
 
CAED 2016 offers an electronic amendment feature.  This feature allows the user to 
make changes to and resend export declarations previously submitted by the CAED 
application. (See Part III for more details). 

Void 
 
This feature allows the user to void and resend previously sent CAED export 
declarations.  (See Part III for more details). 
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OTHER FEATURES 
 
 The CAED application contains time saving features. 
 

• Partly entered forms can be saved as incomplete (Draft) and re-opened and 
completed at a later date. 

 
• The entire HS8 database is embedded in the software.  The database enables the 

user to engage in a keyword search that can be accessed through the commodity 
section. 

 
• Drop down menus exist for Country, Province, Currency, Customs Place of 

Exit, and Unit of Measure (when required). 
 
• Incomplete forms can be printed, but only completed forms can be transmitted.  

Incomplete forms will have the Draft box checked at the top of the form. 
 
• Printing and Reporting can be done individually, by form or with multiple forms. 
 
• Relevant address and reference information are printed on each form.  The 

application is programmed to print a complete form that resembles the Form 
B13A, Export Declaration(06) in appearance. 

 
• When entering data in the postal code or phone number fields, brackets and 

spaces are not required.  These are entered automatically by the application.   
 
• Where applicable, fields are automatically converted to uppercase such as the 

uppercase letters in a postal code. 
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EXPORT DECLARATION DOCUMENT 
 

<<EXPORTER>> FORM SECTION 
 
The Exporter form is the first section of the Export Declaration (B13A) document 
you will see.  This section contains information about the Exporter.  In this context, 
an Exporter is defined as an entity that shows ownership of goods being shipped from 
Canada.  Goods destined for US consumption do not require a B13A.  
 
The information displayed in the Exporter usually remains constant.  Therefore, once 
this information is entered, Memorize the data and/or Memorize as Default. 
 

 
 
Type in the required information and press the Tab key on your keyboard to move to 
the next text box.  Continue to fill out all the text boxes.   
Exporter Text Boxes 
 

Exporter Reference 
Number(s): 

Key in the reference number the Exporter can use to  
track the shipment in the users legacy system (i.e. an 
invoice number or a purchase order number). This field is 
not mandatory but is instead meant for the exporter’s 
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personal use. 
 

Business Number:      Enter the federal government assigned Business Number 
(BN), including the six character account identifier, e.g. 
RM0001, of the person or company that exports the goods 
or causes them to be exported. Note: Administrative 
Monetary Penalty System penalties will be assessed 
against the company whose BN appears on the form. To 
request a BN, visit the Canada Revenue Agency Web site 
at http://www.cra-arc.gc.ca/tx/bsnss/tpcs/bn-ne/menu-
eng.html or call 1-800-959-5525. Exporters outside of 
North America can visit the CRA International Tax 
Services Office Web site at http://www.cra-
arc.gc.ca/cntct/international-eng.html. 
 

Exporter Name: Type in the name of the Exporter or use the drop down 
arrow to access previously memorized names. 
 

Street address: Type in the street address of the Exporter. 
 

City: Type in the name of the city corresponding to the above 
address. 
 

Province/State: Type in the first letter of the Province/State or use the drop 
down arrow to select the correct Province or U.S. state. 
 

Country: Type in the first letter of the Country or use the drop down 
arrow to select the correct Country. 
 

Postal/zip Code: Type in the postal/zip code for the corresponding address 
without spaces.   
 

Authorization ID:  Type in your Statistics Canada assigned Authorization ID. 
 

Telephone: Type in the Exporter’s phone number. 
 

Telephone extension: Type in the Exporter’s extension number, if applicable 
 

Fax: Type in the Exporter’s fax number. 
 

 
Once all the relevant information has been entered in the Canadian Exporter section, 
you can click the Memorize section or Memorize section as default button to add 
the information to the drop down lists.  Once the pertinent information has been 
added, you may then save the section using the Save Section button.  Once the 
section is saved, click on the <<Consignee>> tab to continue.  

http://www.cra-arc.gc.ca/tx/bsnss/tpcs/bn-ne/menu-eng.html
http://www.cra-arc.gc.ca/tx/bsnss/tpcs/bn-ne/menu-eng.html
http://www.cra-arc.gc.ca/cntct/international-eng.html
http://www.cra-arc.gc.ca/cntct/international-eng.html
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<<CONSIGNEE>> FORM SECTION 
 
The second section of the Canadian Export Declaration form refers to the ultimate 
Consignee or, if not available, the Foreign non-US Importer. 
  
 

 
  
Type in the information required and press the Tab key on your keyboard to move to 
the next text box.  Continue to fill out all the text boxes. 
 
Consignee Text Boxes 
 
Consignee Name: Type in the name of the Consignee or use the drop down 

arrow to access memorized names. 
 

Street address: Type in the street address of the Consignee. 
 

City: Type in the city corresponding to the above address. 
 

Province/state: Type in the name of the province/state corresponding to the 
above address. 
 

Country: Type in the first letter of the country or use the drop down 
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arrow to select the correct country. 
  
Once all the relevant information has been entered in the Consignee section, you can 
click the Memorize section or Memorize section as default button and then save the 
section using the Save Section button.  Once the section is saved, click on the 
<<Service Provider>> tab to continue.  
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<<SERVICE PROVIDER>> FORM SECTION 
 
The third part of the Canadian Export Declaration form refers to the service provider 
who fills out and submits the B13 on behalf of his clients much like a broker or 
freight forwarder. 
 

 
 
If you are not a service provider, click the Save Section button.  
 
Otherwise, type in the information required and press the Tab key on your keyboard 
to move to the next text box.  Continue to fill out all the text boxes. 
 
Service Provider Text Boxes 
 

Service Provider Name: Type in the company name of the service provider 
completing the form or use the drop down arrow 
 to access memorized names. 
 

Service provider 
authorization ID: 

If you are a broker, agent or freight forwarder type in 
your Statistics Canada assigned service provider 
authorization ID. 
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Street address: Type in the street address of the service provider  
completing the form. 
 

City:  Type in the city corresponding to the above address. 
 

Province/state: Type in the first letter or use the drop down arrow to 
select the province/state. 
 

Country:  Type in the first letter or use the drop down arrow to 
select the country. 
 

Postal/zip code: Type in the postal/zip code for the corresponding 
address. 
 

Telephone:  Type in the phone number. 
 

Telephone extension:
  

Type in the extension number, if applicable 
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<<CERTIFIER>> FORM SECTION 
 
The fourth part of the Canadian Export Declaration form refers to the person who 
completes the B13A form and certifies that the information contained in this form is 
accurate and complete. 
 

 
 
Type in the information required and press the Tab key on your keyboard to move to 
the next text box.  Continue to fill out all the text boxes. 
 
Certifier Text Boxes 
 

Certifier Name: Type in the name of the person who completed the 
B13A form and certifies that the information is accurate 
and complete, or use the drop down arrow to access 
memorized names.  
 

Company Name: 
 

Type in the name of the certifier company. 
 

Street and No.: Type in the street address of the person who certifies 
that the information in the form is true and complete. 
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City:  Type in the city corresponding to the above address. 
 

Province/state: Type in the first letter or use the drop down arrow to 
select the province/state. 
 

Country: Type in the first letter or use the drop down arrow to 
select the country. 
 

Postal/zip Code: Type in the postal/zip code for the corresponding 
address. 
 

Telephone: Type in the phone number. 
 

Telephone extension:   Type in the extension number, if applicable 
 

Fax: Type in the fax number. 
 

E-mail: Type the address of the person who certifies that the 
information provided in the form is true and complete. 
 

  
     
Once all the relevant information has been entered in the Certifier section, you can 
then use the Memorize section or Memorize section as Default button and then 
Save the Section.  Once the section is saved, click on the <<Commodity>> radio 
button to continue. 
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<<COMMODITY>> FORM SECTION 
 
The fifth part of the Canadian Export Declaration form refers to the goods being 
exported. The main Commodity screen requests information specific to a shipment.  
There are several sub screens that allow for input and/or modification of each 
commodity item or description.   
 
You may create your own Memorized Commodity List for commodities that are 
frequently used.  This memorized list can be edited to add or delete items. 
Each commodity item has a separate Harmonized System (HS) Commodity Code and 
must be completed on a separate line. 
 

1. Click on Commodity tab. 
 

 
 
2. Click on the Add New Line button and the Harmonized System – HS 

Commodity Code Search screen will be displayed. 
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3. The user may search the entire HS Commodity database or search user 
memorized commodity lists. 

 
4. The search may be done either by all or part of the HS Commodity code or 

by the English description of the commodity.  More than one key word 
can be used by entering a space between the words. 
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5. Click on Search Now. Select the required commodity from the list and 

click OK.  The Add Commodity screen will then be displayed. The list of 
HS Codes used by Statistics Canada to gather data for statistical purposes 
is approximately 6,100 items.  However, since Canada Border Services 
Agency requires a more detailed description of many of the exported 
goods, exporters must describe the commodity in their own words. 
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6. Revise the commodity description as required.  This modified description 

can be used for the current form and may be memorized and used again as 
required. The description will remain in the language entered.  

 
7. If applicable, enter the Conveyance ID Number. If the good being 

exported from Canada is a conveyance, enter the vehicle identification 
number (VIN), the hull identification number (HIN) or the serial number 
of the conveyance. Conveyances for export include vehicles, motorcycles, 
all terrain vehicles, boats, etc. This does not include the identification 
number of the transport vehicle used to export the conveyance. 

 
8. Enter the Quantity of the commodity identified above.  Please note the 

Quantity field directly correlates to the Unit Of Measure field. For 
example, a unit of measure in KGM will require the quantity in KGMs. 

 
9. If the Unit Of Measure field is empty, select a unit of measure from the 

drop down menu. 
 
10. Enter the value of the commodity identified.  Please note that the value 

does not include insurance costs, but should include domestic freight 
charges to the Canadian point of exit. 

 
11. Enter Country of Origin of goods and the Canadian Province of Origin 

of the goods by using the drop down menu. All goods exported must have 
a Canadian province of origin. 

 
12. Select OK to add this commodity line and return to the main Commodity 

screen. 
 
13.  The updated Commodity screen will be displayed showing the entered 

data. 
 



 22 

 
 
14. If more than one commodity is being exported within the same shipment, 

please repeat steps 2-12 for each separate commodity. 
  
15. Complete the Commodity section by entering the domestic Freight 

Charges to Canadian point of exit, Gross weight, and Unit of Weight of 
the shipment, and the Currency of the declared value. 

 
16. Once all the relevant information has been entered in the Commodity 

section, click the Save Section button to validate the screen.  Once the 
section is saved, click on the Other export details tab to continue. 
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<<OTHER EXPORT DETAILS>> FORM SECTION 
 
 
The sixth part of the Export Declaration form refers to additional information 
regarding the goods being exported. 
 

 
 
Using the mouse, select the Mode of Transport and press the Tab key on your 
keyboard to move to the next text box.  Continue to fill out all the text boxes. 
 
Other Export Details Text Boxes 
 

Mode of Transport: Click on the check box to select the mode of transport by 
which the goods left the country.  Goods travelling by 
truck to an American port of exit for shipment overseas 
are exported by road.  Mode of Transportation 
corresponds to the method of transportation used to exit 
Canada. 
 

Place of Exit: Select the Province where the goods will leave the 
country, and then select the appropriate Customs office 
that is valid for the selected province. 
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Exporting Carrier 
Name:  

Type in the name that identifies the exporting carrier (see 
Help file. 
 

Transportation      
Document Number: 

Enter the transportation document number pertaining to 
the goods exported.  It is split into 2 fields: Carrier Code 
and Unique Carrier-Assigned Code.  The Carrier Code is 
assigned to the carrier by CBSA.  The Unique Carrier-
Assigned Code is the reference code that the carrier will 
use to track the shipment. 
 

Vessel Name 
(if Marine): 

This field will be activated if the mode of transport being 
used to export the goods out of Canada is marine.  Please 
provide the vessel name.   
 

Are the goods 
containerized? 

Click on the check box to indicate whether the goods are 
containerized.  If Yes, the Container Number(s) box 
will be activated.   
 

Container Number(s): Type in the container number.  If more space is required 
for multiple container numbers, select More.  If you 
know that the shipment will be containerized, but at the 
time of B13A preparation, the numbers are unavailable, 
please select To be determined. 
 

  
 
Once all the relevant information has been entered in the Other Export Details 
section, click on the Save section button to validate the screen. Once validated, click 
on the Customs details tab to continue. 
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<<CUSTOMS DETAILS>> FORM SECTION 
 
 

 
 
The seventh and last part of the Export Declaration form refers to information 
required by the CBSA which pertains to the shipment being exported.  Key the 
information required and press the Tab key on your keyboard to move to the next text 
box.  Continue to fill out all the text boxes. 
 
Customs Details Text Boxes 
 

Are the Goods 
Controlled? 

Click on the check box to indicate whether the goods 
are controlled. 
If the goods are controlled, the Export permit 
number(s) box will be activated.   
 

Export permit 
Number(s): 

State the permit, licence or certificate number for 
goods and technologies subject to export controls. 
This includes goods and technologies covered under 
General Export Permits (GEP).  To enter multiple 
permit numbers, select More. 
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Are the Goods Sold?: Click on the check box to select Yes or No.  If NO is 
selected the reason for export field will be activated. 
 

If No- Reason For 
Export: 
 

Use the drop down arrow to select the reason for 
export. 
 

Packages:  Key the Number and Kind of packages used in the 
specified shipment. (For example, 4 
boxes/pallets/skids/crates). 
 

Country of Final 
Destination: 

Select the country of final destination from the drop 
down list.  This is the country where the goods being 
exported are to be consumed, further processed or 
manufactured.   
 

Date of Exportation: Select the year, month, and day the goods are to be 
exported. 
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PRINTING & SENDING PROCEDURES 
 
Once the form(s) is (are) complete (a green check mark appears beside each form 
section), you should perform the following functions:  
 

• Send the form(s) electronically to STC and CBSA using the embedded 
encryption and transmission protocols. 

 
In addition to the sent document, controlled, regulated and/or prohibited goods must 
have a hard copy of the export declaration attached to the shipment for submission to 
the CBSA, regardless of value or destination. 
 
 

Form Print  
From File, select Print.  The Print sub screen will be displayed.   
 

 
 

• The drop down list contains a list of each month of the current year during 
which forms were entered.   

 
• Select the required year/month from the drop down list.  All forms entered 

that month will be displayed in the bottom section of the screen along with 
their status:  complete, incomplete, amended or void.  If a form is currently 
open it will be highlighted on the list. 
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• Select the form you wish to print from the displayed list.   
 
• To select individual forms in any order, hold down the Control button and 

click on the first form.  Continue to hold down the Control button and click on 
the individual form selections. 

 
• Click Print. 

 
• A form with a status of incomplete will have the Draft box checked at the top 

of the form. 
 
• A form with a status of complete will have the Original box checked at the 

top of the form. 
 
• A form with a void status will have the Void box checked at the top of the 

form. 
 
• A form with an amended status will have the Amended box checked at the 

top of the form. 
 
• The time and date printed below the Amended box refers to the time at which 

the form acquired its status or when its status changes (i.e. from Original to 
Amended). 

 
 

Form Send 
 

From the File menu, select Send.  The Send sub screen will be displayed.  If no form 
is currently open, the Month field will display the current year and the month during 
which the last form was completed.   
 
The drop down list contains a listing, by month, during which forms were entered and 
completed. NOTE: Incomplete forms cannot be sent. 
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• Select the required month from the drop down list.  All completed forms 
entered that month will be displayed in the bottom section of the screen. If a 
form is currently open, it will be highlighted on the list. 

 
• Select a form from the displayed list and then click on Send.   
 
• To select individual forms in any order, hold down the Control button and 

click on the first form.  Continue to hold down the Control button and click on 
the individual form you wish to select.  Click on Send. 

 
• An hourglass will appear on screen indicating that the CAED software is 

reformatting and encrypting the selected export declaration(s).  When the 
process is complete, the Internet Form Transfer screen will appear (see 
below). 

 
• In order to send a form, one of the four displayed transmission protocols [FTP 

(Sysax), FTP (IP*Works), Internet Email, Local Email] must first be selected.  
To select a protocol, click the corresponding radio button.  The transfer 
protocol of choice is FTP(IP*Works). 

 
• From the same screen, click the Options button.  The Transmission Options 

screen will appear containing 5 tabs:  Tab1: FTP (Sysax), Tab2: FTP 
(IP*Works), Tab3: Internet Email, Tab4: Local Email, Tab5: Advanced. 
See next pages for more information on configuring the transmission options.  
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• Once the appropriate tab is completed click the Transfer button to send a 
form. 

 
• Once a form has been sent, click the Save button in the Transmission Log 

section to save your transmission report for future reference. (see Internet 
Form Transfer screen below).  Also, click the Print button in the Proof of 
Report section to print the proof of report, which demonstrates to CBSA that 
the goods have been reported to the government of Canada. 
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TRANSMISSION CONFIGURATION 
 
Once the document is ready to be sent, you must configure the transmission. Once the 
Internet Form Transfer screen appears, select the Options button and the 
Transmission Options screen will be displayed (see below). 
 

 
 

It is also possible to access the transmission options directly without having to transmit a 
form. Select the “Configure Transmission Options” item in “Options” menu. 
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Tab 1 – FTP (Sysax) 
 

 

 
 

STC – 
Server Name 

The domain name or IP address of the Statistics Canada 
(STC) FTP server.  This is the server where you will be 
sending the files.   
 

STC –  
User ID 

The user ID to login to the STC FTP Server 
 
 

STC –  
Password 

The password used to login to the STC FTP Server.   
 
 

STC – 
Remote Path 

The access path on the FTP server.  
 
 

CBSA – 
Server Name 

The domain name or IP address of the Canada Border 
Services Agency (CBSA) FTP server.  This is the server 
where you will be sending the files.   
 

CBSA –  
User ID 

The user ID to login to the CBSA FTP Server.   
 
 

CBSA – 
Password 

The password used to login to the CBSA FTP Server.   
 
 

CBSA –  
Remote Path 

Access path on the FTP server 
 
 

Passive Mode Select this check box if a firewall is installed on your server. 
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Normally, the data connection occurs from the government's 
server to your company's server. If a firewall exists, the 
connection will be blocked by your company's server. The 
FTP-Data connections will be initiated the opposite way 
from what is normal by opening the connection from your 
company to the government's server.    Use Passive mode to 
overcome this problem. 
 

Reset button Use this button to reset the check box Passive Mode to its 
default value. 

 
 

Tab 2 – FTP (IP*Works) 
This tab is identical to the tab 1 - FTP (Sysax). 
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Tab 3 – Internet Email (SMTP) 
  

 
 
STC Email An email address for data transmitted to Statistics Canada 

(STC). 
 
Typically, caed3@statcan.gc.ca 
 

CBSA Email An email address for data transmitted to Canada Border 
Services Agency (CBSA). 
 
Typically, cgwcaed@cgp.cbsa-asfc.gc.ca 
 
 

Server Address or 
Name 

The name or address of your mail server (mail relay).  This is 
the name of your SMTP server that you use to send email. 

 
The Host Name specifies the IP address (IP number in dotted 
internet format) or Domain Name for a mail relay through 
which messages will be routed.  
 

Port Number This refers to the Internet server port that is designated for 
SMTP mail service. Conventionally, port 25 is used for SMTP 
mail, which is the default value of the property. 
 

Email User Id When it is necessary to logon to the underlying mail system, 
the Email User Id property used is the account user ID. 
 

Password Specifies the mail login password.  Login occurs 
automatically, when the first email message is sent.  

mailto:caed3@statcan.gc.ca
mailto:cgwcaed@cgp.cbsa-asfc.gc.ca
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Your Email Addr. The email address of the sender (required).   

 
This property is used to create a From SMTP header.  This 
header identifies the sender of the message.  A valid email 
address is required.     
 

Use Attachment 
Box 

Selecting this checkbox configures the email to send data as 
an attachment rather than inside the body of the message. 
 

Use Secure 
Connection box 

Selecting this checkbox configures the email to request a 
secure (encrypted) connection be used when communicating 
with the specified mail server. 
 

Reset Button Use this button to reset the following fields to their default 
values: 
- STC Email 
- CBSA Email 
- Port Number 
- Use an attachment for the encrypted form 
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 Tab 4 – Local Email (MAPI) 
 

 
 

STC Email This field is set to caed3@statcan.gc.ca.  This is the 
recipient of the CAED mail messages for Statistics 
Canada.  You may have to create an alias in your mail 
application. If so, you must set-up both the alias name 
and the address to caed3@statcan.gc.ca. 

 
CBSA Email This field is set to cgwcaed@cgp.cbsa-asfc.gc.ca.  

This is the recipient of the CAED mail messages for 
Canada Border Services Agency.  You may have to 
create an alias in your mail application. If so, you 
must set-up both the alias name and the address to 
cgwcaed@cgp.cbsa-asfc.gc.ca. 
 

Email User Id When it is necessary to logon to the underlying mail 
system, the Login Name property used is the account 
name/user ID. If not provided, the application will 
provide a prompt (when required).  When interfacing 
to Microsoft Exchange, this property may also be used 
to set the profile name. 
 

Password Specifies the mail login password.  Login occurs 
automatically, when the first email message is sent.  
 

Your Email Address The email address of the sender (required).   
 

Use an attachment for the 
encrypted form 

Selecting this checkbox configures email to send data 
as an attachment rather than inside the body of the 
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message. 
 

Reset Button Use this button to reset the following fields to their 
default value: 
- STC Email 
- CBSA Email 
- Use an attachment for the encrypted form 
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Tab 5 – Advanced  
This tab has many sub-tabs. 

Tab 5.1 – Advanced / General 

 
 

Use Extended 
Transmission Logging 

Selecting this checkbox configures the transmission 
process to generate additional log information. 
The extra information can be useful to resolve a 
transmission issue. 
Do not use this option if you have no transmission 
issues. 
 

Unlock controls This option is only used by Statistics Canada to test 
the software. 
 

Reset Button Use this button to reset the following fields to their 
default value: 
- Use Extended Transmission Logging, 
- Unlock controls. 
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Tab 5.2 – Advanced / Firewall 

 
 

Auto-Detect Selecting this option configures “FTP (IP*Works)” 
and “Internet Email (SMTP)” to detect and use 
firewall system settings, if available, for transmission.  
 

Manual (Detect) Selecting this option configures “FTP (IP*Works)” 
and “Internet Email (SMTP)” to use custom firewall 
system settings for transmission.  
 

Type Determines the type of firewall to connect through. 
The applicable values are the following: 
• Empty No firewall 

 
• Tunnel Connect through a tunnelling proxy 

server. 
Selecting this option sets the IP*Works 
Firewall Port Number attribute to 80. 
 

• Socks4 Connect through a SOCKS4 Proxy 
server. 
Selecting this option sets the IP*Works 
Firewall Port Number attribute to 
1080. 
 

• Socks5 Connect through a SOCKS5 Proxy 
server. 
Selecting this option sets the IP*Works 
Firewall Port Number attribute to 
1080. 
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Host Domain name or IP address (in internet dotted format 
aaa.bbb.ccc.ddd) of firewall when using IP*Works 
components for transmission. 
 

Port The port number (between 1 and 65535) of the 
firewall. 
 

Authenticate Select this option to enable the following fields: 
- User 
- Password 
 

User A user name if authentication is to be used connecting 
through a firewall. If the Host is specified, the User 
and Password fields are used to connect and 
authenticate to the given firewall. 
 

Password A password if authentication is to be used when 
connecting through the firewall. If Host is specified, 
the User and Password fields are used to connect and 
authenticate to the given firewall. 
 

Reset Button Use this button to reset the following fields to their 
default value: 
- Auto-Detect / Manual, 
- Type, 
- Host, 
- Port, 
- Authenticate, 
- User, 
- Password. 
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Tab 5.3 – Advanced / FTP 
 

 
 

STC Additional FTP 
Commands 

This field is normally empty. However, it may be used 
to send additional FTP commands directly to the 
Statistics Canada server. 
 

CBSA Additional FTP 
Commands 

This field is normally empty. However, it may be used 
to send additional FTP commands directly to the 
Canada Border Services Agency server. 
 

Reset Button Use this button to reset the following fields to their 
default value: 
- STC Additional FTP Commands, 
- CBSA Additional FTP Commands. 
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Tab 5.4 – Advanced / Local Email (MAPI) 
 

 
 
 

Force Initialization Force the initialization of the MAPI component before 
logon. 
 

Reset Button Use this button to reset the field “Force Initialization” 
to its default value. 
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Tab 5.5 – Advanced / Internet Email (SMTP) 
 

 

 
Authentication 
Mechanism 

The type of authentication to use when connecting to a 
SMTP server. Values are one of: 
 
• Login ID and password sent in clear (base64) 
 

 

• Challenge Response Authentication 
Mechanism MD5 (encrypts Login ID and 
password) 

 

 

• Microsoft Single Sign-On Authentication 
Mechanism. Supported by Microsoft 
Exchange Server 

 

 

 

Additional SMTP 
commands 

This field is normally empty. However, it may be used 
to send additional SMTP commands directly to your 
mail server. 
 

Reset Button Use this button to reset the following fields to their 
default value: 
- Authentication mechanism, 
- Additional SMTP commands. 
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PART III 
 
The proceeding section outlines in detail, the following features of the software:   
  

• Create a new Template  
• New From Template, 
• Void Sent Form  
• Void Unsent Form 
• Unvoid 
• Amend sent Form  
• Memorized Lists  
 

CREATE A NEW TEMPLATE 
You may use this feature to create a template from any previously completed form. 
 

• From File, select Create a New Template.  This will bring you to the Export 
Declaration-Create a Template Screen.  Select the declaration form to use as 
a template for a new export declaration, then click Create. 

 

 
 
• A screen will then appear prompting you to name the template.  Type in an 

identifiable name either to the item being exported or the exporting company 
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that the new export declaration refers to and press Save.  You have now 
created a New Template.   

 

 
 
• Repeat the process for additional templates. 

 

NEW FROM TEMPLATE 
 

• From File, select New from Template.  The screen that appears contains a list of 
all named declaration forms that the user has created as templates.  Select the 
declaration form that you would like to use as a template, and then select Open. 

 

 
 
• The selected export declaration will open, allowing the user to make any 

necessary changes to the data.  To make changes, select the appropriate section, 
make the necessary changes and press the Save Section key. Once all necessary 
changes to the export declaration have been completed and saved, the user may 
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send the new export declaration by following the transmission procedures. The 
new form, with a unique Form ID, will then be sent. 

 

VOID -SENT FORM 
 
To void an export declaration that has been previously sent, open the Form by selecting 
Open from the File menu.  A screen will appear that lists all export declarations that the 
user has previously sent.  Select the declaration form from the list that you would like to 
void and click OK.  Once the declaration appears, select Void from the File menu.  Once 
void has been selected, the following message will appear:   
 

 
 
Select Yes and proceed with the normal send procedure.  Once the voided export 
declaration has been sent, the date and time that the voided form was transmitted will 
appear inside the transmission date box. 
 

VOID – UNSENT FORM 
 
To void an export declaration that has not been sent, open the form by selecting Open 
from the File menu.  Select the declaration and click OK.  When the declaration appears, 
select Void from the File menu.  A message will appear that states “Are you sure you 
want to void this form?”  Select YES.   
 
**Note: an uncompleted Export declaration that has been voided cannot be sent 
through CAED. 
 
 

UNVOID 
 
To unvoid a previously void form, Open the selected form and then Select File, then  
Unvoid from the File menu. 
 
A form that has been transmitted and voided cannot be unvoided. 
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AMEND SENT FORM 
 
Electronic amendments to completed export declarations can be submitted by use of the 
CAED software.  To amend a previously sent document, Select Amend Sent Form from 
the File menu.  A screen will appear which lists all export declarations that the user has 
previously sent using the CAED software.  From the list, select the declaration that you 
would like to amend and click Amend. This will bring up the specified export 
declaration. Any necessary adjustments to the data can now be made by selecting the 
appropriate section and clicking Amend form at the upper right of the screen.  Make the 
necessary changes to each section’s data and then click Save Section.  Once all the 
necessary changes have been made, the amended export declaration can be resent by 
following the normal Send procedure. 
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To amend a completed form that has not been sent, open the declaration and choose 
the Edit Form option located at the upper right of the screen.  Make the necessary 
alterations and Save the Section. 
 

MEMORIZED LISTS 
 
Five sections in CAED allow the user to memorize data for future use.  They are the 
Canadian Exporter, Consignee, Service Provider, Certifier and Commodity sections. 
 

• To amend or delete memorized data, select Edit then Memorized Lists and then 
select the section.   

 
• The section selected will list all of the memorized data.   
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• To eliminate a memorized section, select the data to be deleted and click Delete.   
 
• If you have default values for the selected section, then it will appear in red. 

 
• You can fix default values by selecting an item in the list and by clicking on the 

button Set as default section. The default values appear automatically when you 
create a new form and they are useful to save time. 

 
• If you want to eliminate you default values for a section, you just have to click on 

the button Remove default section. 
 
• It is not possible to amend the memorized data from this screen. To amend data, 

select Delete, then re-memorize the correct data when completed. 
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PART IV 
 
Other software features available to CAED clients:  
 
 

CAED REPAIR FUNCTION 
 
For the majority of cases, the CAED application will be able to detect if your database is 
damaged or corrupted.  A tool has been built into CAED that will assist in the repair 
process of your database.  
 

• Select Start, then Program. 
 

• Click on the CAED Icon and then the Repair Icon. 
 

• If the repair operation succeeded then you will have the following message: 
 

 
 
  

BACKUP PROCEDURE 
 
It is necessary to backup the form database on a regular basis, regardless of whether your 
system is a stand-alone or multi-user.   
All Exporters are required by Canada Border Services Agency to maintain an accurate 
record of all export documents. 
 
To begin the Backup procedure:  

• From the Main application screen, select File. 
 
• Select Backup/Restore, The Backup / Restore sub-screen is displayed. 
 
• Select the drive and folder and enter the Backup File Name. 
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• Click the Backup button.  
• The message “Backup Completed.” will appear.  

 
Please note that the Back-up will override all previously saved data if the same file 
name is reused. 
 
 
 

RESTORE PROCEDURE 
 
If it is necessary to restore your database follow the following procedures.  This feature 
will only be successful if a Backup is done on a regular basis. 
 
To begin the Restore procedure:  
 

• From the Main application screen, select File. 
 
• Select Backup / Restore, the Backup / Restore sub-screen is displayed. 
 
• Select the drive, the folder and the backup file name. 
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• Click the Restore button. 
 
• A confirmation message will appear. Click OK. 

 

 
 
• During the restore process a progress window will appear. 
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• Finally, the message “Restore completed!  The application will now close.  
Please restart CAED to continue." will appear. 

 
• Click OK 
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PART V 
 

UNITS OF MEASURE 
 
As referenced from the Commodity Screen 
 

Abbreviation 
 

English Description 
 

CTM Carat 
DPR Dozen Pairs 
DZN Dozen 
GBQ Gigabecquerel 
GRO Gross 
GRM Gram 
KGM Kilogram 
KNS Kilogram of Named Substance 
LPA Litres of Pure alcohol 
LTR Litre 
MBQ Megabecquerel 
MIL Thousand 
MTK Square Metre 
MTR Metre 
MTQ Cubic Metre 
MWH Megawatt Hour 
NAP Pack 
NMB Number 
PAR Pair 
SFA Square Feet ¾" thick 
SFE Square Feet ⅛" thick 
SFF Square Feet ⅝" thick 
SFH Square Feet ½" thick 
SFP Square Feet 1" thick 
SFQ Square Feet ¼" thick 
SFT Square Feet ⅜" thick 
TMQ 1000 Cubic Metre 
TNE Metric Tonne 
TSD Tonne Air Dry 
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PROBLEMS OR QUESTIONS 
 

CBSA Related Questions 
 
For general information on exports refer to the D20-1-1 memorandum or contact:  
 
Canada Border Services Agency 
Export Process 
 
Phone: (613) 954-7160 or 1-800-461-9999 for calls in English and 1-800-959- 
2036 for calls in French 
 
Direct access to an agent is available from 08:00-16:00(Mon.-Fri.), EST. 
 
WebSite: http://www.cbsa-asfc.gc.ca   
 
 

CAED Help Line & Export Commodity Codes 
 
For CAED software help and Canadian export commodity codes contact: 
 
International Trade Unit, 
Operations and Integration Division, 
Statistics Canada 
 
Phone: (613) 951-6291 or 1-800-257-2434 
Fax: (613) 951-6823 or 1-888-269-5305 
Email: export@statcan.gc.ca 
WebSite: http://www.statcan.gc.ca/exp/index-eng.htm 
Hours of Operation: 8:00 – 16:30 (Mon.-Fri.), EST 

http://www.statcan.gc.ca/exp/index-eng.htm
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